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Section O.
Quick Installation Guide

0.1. Quick installation guide

Users familiar with license management software can quickly browse through the following steps in
order to download and install beta_Im_tools. Numbers in the third column indicate the
corresponding paragraphs where detailed information on each specific step is given.

Action

Paragraph

1.

Decide on the machine that will be used as license server. If a server redundancy
scheme is to be used, decide on its type and on the machines that will be used as
license servers.

1.2
221

Log on to BETA CAE Systems server and download beta_lm_tools for each machine
and platform that will be used as a server.

222

On each of these servers, unpack beta_lm_tools and execute the command:
beta 1Im -host key

Store the outcome of the above command, which consists of the beta_Im version,
the machine’s hostname, the machine's ethernet card MAC address and a string of
forty (40) characters, like:

BETA LM v7.x

BETA LM Host Name = Gauss

MAC = 00:0f:b0:43:34:9a

BETA LM Host Key = 200a025ec00b5f5e0f1b2e1b3d5e020bd04e5144

On WINDOWS systems only, the administrator has the option to extract the above
key based on another network interface, namely USB or WiFi. To produce such a key,
use the command:

beta Im -host key -ni [network interface, e.g. USB | WiFi]

224
225

Provide the above to BETA CAE Systems. Using these data, BETA CAE Systems will
generate the corresponding license file, usually called license.dat

2.2.6
5.1

Copy the license.dat file on each server and install the beta_Im license daemon using
the commands:

Linux Systems:
beta Im -f [full path to]license.dat -L
[full path to]license.log

227

BETA CAE Systems
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Windows Systems:

beta Im -install -f [full path to]license.dat -L
[full path to]license.log

Alternatively, the single name of the license (license.dat) and the license.log files
can be used, if navigated to the directory where the license file is located.

If the administrator used a USB or a WiFi network interface to extract the server
host key, then this interface should also be declared during installation:

beta Im -install -ni [USB | WiFi] -f
[full path to]license.dat -L [full path to]license.log

Start the "BETA LM Service" from:
Control Panel > Administrative Tools > Services

Verify that beta_Im is up and running on each server, using the command:

beta 1Im stat -h server name

The outcome of the above command will display the features available within the
license.dat file.

Note that in the "hardware failover" redundant server scheme, only the server that is
currently the "primary" will respond.

! Note: On the server machine, ensure that there is an inbound firewall rule which
allows incoming traffic on the specific TCP port used by BETA LM, for example for
the default TCP port 6007.

227

On the client machines, modify the BETA_LIC_SRV environment variable to match the
server settings.

For example, in the three server "hardware failover" scheme, one can set a
“permanent” environment variable with BETA LIC SRV as a name and
port@serverl,port@server2,port@server3 as a value.

6.1.1
6.1.2

Launch a licensed application (e.g. ANSA, META) using the provided execution
scripts.

For troubleshooting actions please refer to section 8.

0.2. Updating to newer version

6.1

When updating to a newer version of beta_lm_tools and in case that the server machines have not
changed, one needs to follow the steps as described below.

Action Paragraph
1. | Terminate the old version of beta_lm_tools. 3.1.1
2. | Log on to BETA CAE Systems server and download beta_lm_tools for each machine 222
and platform that are used as a server.
BETA CAE Systems Page 5
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3. | On each of these servers, unpack beta_Im_tools and install the beta_lm license 224
daemon using the commands: 297
Linux Systems:
beta Im -f [full path to]license.dat -L
[full path to]license.log
Windows Systems:
beta Im -install -f [full path to]license.dat -L
[full path to]license.log
and start the "BETA LM Service" from:
Control Panel > Administrative Tools > Services
Alternatively, the single name of the license (license.dat) and the license.log files
can be used, if navigated to the directory where the license file is located.
If the administrator used a USB or a WiFi network interface to extract the server
host key, then this interface should also be declared during installation:
beta Im -install -ni [USB | WiFi] -f
[full path to]license.dat -L [full path to]license.log
4. | Verify that beta_lm is up and running on each server, using the command: 2.2.7

beta Im stat -h server name

The outcome of the above command will display the features available within the
license.dat file.

currently the "primary” will respond.

Note that in the "hardware failover" redundant server scheme, only the server that is

When updating to a newer version of beta_lm_tools and in case that the server machines have changed

or they are Virtual Machines one should follow the steps as described in section 0.1.

BETA CAE Systems
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Section 1.
Introduction to beta_lm_tools

1.1. Basic components

beta_lm_tools is the license manager package for use with all products licensed by BETA CAE
Systems and should be downloaded and installed on all machines that are designated as license
servers. The package contains the following:

e Dbeta_Im: license daemon that handles the initial contact and communication with the
licensed application through a TCP/IP network protocol. The communication itself is
machine independent, so the licensed application and the license daemon can be running on
different platforms and different operating systems

e beta_lm_stat: a reporting tool that provides information on license usage
e beta_Im_kill_user: a tool to terminate process of specific users
¢ beta_lm_control: a tool to communicate with the license manager for various tasks

e an optional administration options file (usually called license.opt) that can be used by the
license administrator to control various operating parameters of beta_Im. All configurable
parameters that appear in the administration options file remain within the license rights
granted by BETA CAE Systems

e related documentation on the installation and maintenance of beta_lm_tools

Upon installation, the beta_Im license daemon searches for and reads the license file, usually called
license.dat. This is a standard ASCII file storing all licensing information necessary for the proper
and uninterrupted use of the licensed application. This information is related to the license servers
and the respective communication ports, the licensed software packages and features that the
customer can use etc. The license file is created by BETA CAE Systems in accordance to the
requirements set by the customer and is installed by the license administrator.

1.2. Overview of features

The main features of the beta_Im licensing system are the following:

e License server redundancy: two redundancy schemes are currently available - one for load
distribution using more than one servers and one for hardware failover protection

e Flexible short term licensing

e Group licensing: where a group of specific software products or software features can be
set to hold a specific amount of the total available licenses

e Shared licensing: multiple executions of the same application by the same user on the same
machine/console and on the same license server will occupy a single license

e Idle User timeout and Kill User functionality

BETA CAE Systems Page 7
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¢ On-Line statistics and Logging

1.3. Hardware requirements

Minimum hardware requirements for the installation of beta_Im_tools package are given below:

LINUX 64bit OS Version

AMD Athlon 64, glibc 2.3.2
AMD Athlon 64FX, glibc 2.3.2
AMD Opteron, glibc 2.3.2
INTEL Xeon EM64T, glibc 2.3.2

WINDOWS 64bit OS Version

AMD Athlon, WinXP Pro x64, SP1
INTEL Pentium IV, WinXP Pro x64, SP1
Windows Server 2003/2008

BETA CAE Systems Page 8
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Section 2.
Installing beta_lm_tools

2.1. Overview of actions

The license administrator should take the following actions prior to installing the license
management package:

e Select a suitable license server scheme and decide on the platforms to be used as servers
¢ Download beta_Im_tools package for the above platforms

e Provide to BETA CAE Systems all information needed to generate a valid license file

e Receive a valid license file

Once the license file is received, then

e Dbeta_Ilm license daemon must be launched on all license servers

Details on these actions are given below.

2.2. Installation procedure

2.2.1. Select a suitable license server scheme

The beta_Im license management system supports a stand-alone scheme and two server
redundancy schemes:

e Stand-alone Scheme: In this case beta_Im is installed in a single machine that is designated
by the customer as the license server. The server responds to all requests for license and
serves the total number of available licenses. The stand-alone scheme is considered the
default, unless a redundancy scheme is explicitly specified by the customer.

e Hardware Failover Scheme: This is a quorum scheme, i.e. a scheme of three license servers
where if any two of the three machines are up and running, the system is functional and
serves the total number of licenses. This scheme is commonly known as two-over-three
scheme and is designed to provide hardware failover protection.

e Multiple Servers Scheme: The total number of licenses can be distributed (equally or not) to
any number of machines that will be used as alternate license servers. Under this scheme,
each time a license is requested, the client will try to engage this license from the first server.
Upon denial, the client will automatically request license from the next available server and
so on, until it succeeds or reaches the end. This type of redundancy is best suited for
distributing license requests, but has the disadvantage that if one server becomes
unavailable, the corresponding licenses that this server distributes become unavailable as
well.

2.2.2. Download beta_lm_tools
In order to get the beta_lm_tools license management package follow these steps:

BETA CAE Systems Page 9
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e Decide on the machine(s) that will be used as license server(s)

e Visit http://www.beta-cae.com and sign in to BETA CAE Systems secure site

e Enter the LICENSE MANAGER section, under the [Downloads] area, located on the left.

e Locate the latest version of BETA_LM_TOOLS package and switch into the respective folder

e Download the compressed files that represent the hardware platforms to be used as license
Sservers:

LINUX Platforms | WINDOWS Platforms
beta_lm_tools_[version]_[platform].tar.gz | beta_Im_tools_[version]_[platform].zip

For example,

- to install beta_Im_tools v7.x on a Linux 64bit machine, you need to download the
beta lm tools v7.x linux.tar.gz file

- to install it on a 64bit Windows platform, you need to download the
beta lm tools v7.x win64.zip file

e Optionally, download the license administration options file, license.opt

2.2.3. Verification of the download using Message Digest-5 (MD5) hash function

A. LINUX Platforms

On the download list of beta_Im_tools you will notice that each compressed file has a respective
md5sum file. This can be used to verify that the compressed file was downloaded correctly
using the standardized MD5 checksums.

For example, imagine that you need to verify the correctness of beta_lm_tools_v7.x_linux.tar.gz.
To do so, download the beta_lm_tools_v7.x_linux.tar.gz_md5sum file and place in the same
location as beta_lm_tools_v7.x_linux.tar.gz:

| PlatformFiles
beta Im_tools_v7.x_linux.tar.gz,
beta_lm_tools_v7.x_linux.tar.gz_md5sum

Then open a command shell, switch into this location where these files reside and type the
command:

md5sum -c beta lm tools v7.x linux.tar.gz md5sum

If the outcome of the above command is OK, then the compressed file was downloaded
correctly; if not, you need to download it again.

B. WINDOWS Platforms

If the Windows version of the beta_Im_tools package is downloaded on a LINUX machine, then
its correctness can be verified as above, by downloading the respective md5sum file and using
the built-in md5sum command. For example:

| PlatformFiles
beta_lm_tools_v7.x_win64.zip
beta_lm_tools_v7.x_win64.zip_md5sum

Then open a command shell, switch into the location where the above files reside and type the
command:

md5sum -c beta Im tools v7.x win64.zip md5sum

BETA CAE Systems Page 10
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If the outcome of the above command is OK, then the compressed file was downloaded
correctly; if not, you need to download it again.

However, if the Windows version of beta_lm_tools package is downloaded on a Windows
machine, then a third party tool should be used for the verification, since Windows may not have
a built-in md5sum utility. Please refer to http://en.wikipedia.org/wiki/Md5sum

2.2.4. Unpack beta_lm_tools package

A. LINUX Platforms

e openacommand shell and switch into the location where the beta_Im_tools package files
reside

e unpack the package:

tar -zxvf beta Im tools v7.x linux.tar.gz

e when unpacked, the following directory structure will be created:

directory structure notes
/beta_1lm_tools - root-folder of

beta_Im_tools package

/linux - sub-folder indicating the
current platform

beta 1m

beta_lm stat contents of beta_lm_tools

beta 1m kill user package

beta_1lm control

e Optionally, if you have downloaded the license administration options file license.opt,
copy this file to the location of the beta_Im_tools files, so the contents of the beta_lm_tools
package now become:

directory structure notes
/beta_lm tools — root-folder of
beta_Im_tools package
/linux — sub-folder indicating the

current platform
beta_1m

beta 1lm stat
beta lm kill user contents of beta_lm_tools

beta_lm:cont;ol paCkage
license.opt

B. WINDOWS Platforms
e Open afile explorer and double click on the beta_lm_tools compressed zip file. A currently
installed archive package (like WinZIP, WinRAR) or the Windows built-in tool will be launched

e Select a suitable location to unpack beta_lm_tools

NOTE: It is recommended to avoid paths with empty spaces, like ..\Program files\ etc. and prefer
an exemplary path, like e.g. C:\beta_Im\ etc

¢ when unpacked, the following directory structure will be created:

directory structure notes
\beta_lm tools - root-folder of
beta_Im_tools
package

BETA CAE Systems Page 11
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\winé4 —  sub-folder indicating

the current platform
beta_lm.exe contents of
beta_1lm stat.exe beta_Im_tool
beta 1m kill user.exe eta_lm_tools
beta 1lm control.exe package

e Optionally, if you have downloaded the license administration options file license.opt, copy
this file to the location of the beta_lm_tools files. So, the contents of the beta_lm_tools
package now become:

directory structure notes
\beta 1lm tools - root-folder of
beta_Im_tools
package
\winé64 - sub-folder indicating

the current platform
beta 1lm.exe

beta_lm stat.exe contents of
beta_lm kill user.exe beta_Im_tools
beta_1lm control.exe package

license.opt

2.2.5. Information required to build a valid license file

In order to build a valid license for the selected license scheme, BETA CAE Systems requires three
pieces of information for all machines that will be used as license servers. This information, its
description as well as the respective command that should be used to obtain it is given in the table
below:

command

Item description (all platforms)

name by which this machine is

1 hostname identified within the customer's

network beta_1lm -host_key
2 MAC address media access control address
3 host key beta_lm alphanumeric string

Important in WINDOWS platforms only: By default, beta_Im targets the ethernet card in order to
generate the required host key. However, in Windows platforms only, the user can explicitly ask to
generate a host key based on an existing USB or WiFi installed network adapter. To do so, the -ni
(standing for network interface) flag should be used, followed by an argument pointing to the
desired network interface:

Iltem description command (WINDOWS only)
name by which this machine is .
. . . ) 1m -h key - B
1 hostname identified within the customer's beta_Im -host key -ni US
network or
2 MAC address media access control address beta_lm -host key -ni WiFi

beta_Im alphanumeric string based
on a USB network interface

beta_lm alphanumeric string based on
a wireless interface

3a host key from USB beta_lm -host_key -ni USB

3b host key from WiFi beta_lm -host_key —ni WiFi
NOTE: In both LINUX and WINDOWS platforms, the required host key can also be generated based
on the machine’s Universally Unique Identifier (UUID), by using the -ni flag, followed by the
argument UUID.
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On Windows 10 OS, enabling the ‘Virtual Machine Platform’ feature (e.g. for the use of Windows
Subsystems for Linux (WSL) v2) or the ‘Hyper-V’ feature, causes BETA LM to produce a Host Key
based on the machine’s UUID.

On Windows Servers 0S, enabling the ‘Hyper-V’ role causes BETA LM to produce a Host Key based
on the machine’s UUID.

In addition, on Virtual Machines explicitly, executing beta_lm —host_key with or without —ni UUID or
USB options, leads to the same host_key result.

Item description Command

beta_Im alphanumeric string beta lm -host_key -ni UUID
1 hostkey fromUUID "' ' on the UUID - -

In addition, when it comes to installation, the following commands should be used:

Linux Systems:
beta Im —ni UUID -f [full path to]license.dat -L [full path to]license.log

Windows Systems:

beta Im -install —-ni UUID -f [full path to]license.dat -L
[full path to]license.log

The process above should be followed on all machines that are designated as license servers. For
example, for a three server hardware failover scheme the customer should provide three sets of
information, one for each server:

server1l command response

1 hostname Gauss

2 MAC beta lm -host key 00-11-D8-AA-5C-3C

3 host key 200a025ec00b5£f5e0f1b2e1b3d5e020bd04e5144
server2 command response

1 hostname Riemann

2 MAC beta 1m -host key 00-11-D8-AA-5B-FD

3 host key 200a025ec00belb3d5e020bd04e51445F5e0f1b2
server3 command response

1 hostname Hilbert

2 MAC beta 1m -host key 00-14-22-DC-C6-EC

3 host key 200a025ab5f5e0f1b2elbec003d5ebd04e510203

2.2.6. Receive a valid license file

Upon acceptance of the above information, BETA CAE Systems will proceed to the generation of a
valid license file, usually called license.dat. This file should be placed to all license server machines,
preferably at the same location where beta_lm_tools files reside. Thus, the contents of the
beta_Im_tools for a 64bit windows will become:

directory structure notes
\beta_lm tools — root-folder of beta_Im_tools
package
\winé4 - sub-folder indicating the

current platform
beta_ 1lm.exe
beta_1lm stat.exe
beta 1lm kill user.exe contents of beta_lm_tools
beta_1lm control.exe package
license.opt
license.dat

Details on the contents of the license file are given in a dedicated paragraph later.
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2.2.7. Launching the beta_lm license manager

The license manager is installed by the license administrator using the beta_lm command with the
appropriate options. When this command is invoked, beta_lm will look for a valid license file at the
location indicated by the administrator. The described process must be followed for all machines
that will be used as license servers.

A. LINUX Platforms

e open a command prompt and switch into the folder containing the beta_Im_tools files, e.g. :
cd ~/beta_lm tools/linux 64

e issue the command:

beta_1lm -f ~/beta_lm tools/linux 64/license.dat -L
[full path to]license.log

NOTE: Alternatively and given that we have navigated to the directory where the license file is
located, the single name of the license.dat and license.log files can be used, instead of the
full file address.

The above command will launch the beta_lm license daemon, read the license file
(license.dat) and write any related messages into a log file (license.log).

e Verify that beta_Im is installed and that the total number of available licenses is correct
using the command:

beta 1lm stat -h server name
the result should, for example, look like:
Trying 6007@server name ....
Found License daemon on server_name

STATUS REPORT

PACKAGE | ISSUED | EXPIRE |  CREDIT
PRE_POST | Wed Sep 11 2019 | Mon Oct 26 2020 | 5000 first section
NEW_ANSA CATIA V5 | Wed Sep 11 2019 | Mon Oct 26 2020 | 300
PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE_POST :ANSA | 5000 | 100 I 2(%) |1
PRE_POST : ANSA_BATCH | 5000 | 0 I 0(2) | O second section
PRE_POST:META_POST | 5000 | 0 | 0(%) | 0
PRE_POST:ANSA_CATIA V4 | 250 | 0 | 0(%) | 0
NEW_ANSA_CATIA V5 | 250 | 0 I 0(2) | O
PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE third section
PRE_POST | 5000 | 100 I 2(%)

At the first section, we get information on the active licensed packages along with the
duration and the corresponding credits of each package.

At the second section, we get information about the current usage of each feature,
i.e. of each licensed application that is currently running.

At the third section, the current usage per package is shown. The information is available
both as an absolute value of used credits, as well as a usage percentage, over the total
amount of credits available for this package.

In addition, the contents of the license.log file should initially look like:

NEW LOG AT Tue May 05 08:12:33 2020
FEATURE | USER NAME@HOST | PID | START | END | EXIT INFO | OS | Version
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B. WINDOWS Platforms

e open acommand prompt and switch into the folder containing the beta_Im_tools files,
for example:

cd c:\beta_lm tools\win64

¢ by default beta_lm considers that the host key used to produce the license.dat file is based
on the ethernet card of the server machine. In this default case, the beta_Im installation
command should be:

beta_lm -install -f C:\beta_lm tools\win64\license.dat -L
[full path to]license.log

However, if a USB or WiFi network interface was used to build the host key, then the same
network interface must be declared at the installation command. For example, in the USB
case the installation command should be:

beta_lm -install -ni USB -f C:\beta_lm tools\win64\license.dat -L
[full path to]license.log

NOTE: Alternatively and given that we have navigated to the directory where the license file is
located, the single name of the license.dat and license.log files can be used, instead of the
full file address.

The above command will install a SERVICE for the beta_Im license daemon.
At this stage, licenses are still not available for use, since the SERVICE is not yet "Started".

¢ Go to Start > Control Panel > Administrative Tools and double-click on Services.
This action will display a list with all services installed on the machine.

e Locate the BETA LM Service and verify that is has a Stopped status.

e Right-click on the BETA LM Service and ask to Start it. During initiation of the BETA LM
Service, the beta_Im license daemon is activated, it reads the license file (license.dat) and
writes any related messages into the log file (license.log).

¢ Right-click again on the BETA LM Service, go to Properties and, under the General tab.
If needed, change the Startup Type to Automatic. This will force the beta_lm license daemon
to automatically start after each reboot.

e Verify that beta_Im is properly installed and that the total number of available licenses is
correct using the command:

beta 1lm stat -h server name

The result should, for example, look like:
Trying 6007@server name ....
Found License daemon on server_name

STATUS REPORT

PACKAGE | ISSUED | EXPIRE | CREDIT
PRE_POST | Wed Sep 11 2019 | Mon Oct 26 2020 | 5000 first section
NEW_ANSA CATIA V5 | Wed Sep 11 2019 | Mon Oct 26 2020 | 300
PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE POST:ANSA | 5000 | 100 | 2 (%) | 1 .
— second section
PRE_POST:ANSA BATCH | 5000 | 0 | 0(%) | 0
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PRE_POST:META POST | 5000 | 0 I 0(%) | 0
PRE_POST:ANSA_CATIA V4 | 250 | 0 | 0(%) | 0 second section
NEW_ANSA CATIA V5 | 250 | 0 | 0(%) | 0
PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE third section
PRE_POST | 5000 | 100 | 2(%)

At the first section, we get information on the active licensed packages along with the
duration and the corresponding credits of each package.

At the second section, we get information about the current usage of each feature, i.e. of
each licensed application that is currently running.

At the third section, the current usage per package is shown. The information is available
both as an absolute value of used credits, as well as a usage percentage, over the total
amount of credits available for this package.

In addition, the contents of the license.log file should initially look like:

NEW LOG AT Tue May 05 08:12:33 2020
FEATURE | USER NAMEQHOST | PID | START | END | EXIT INFO | OS | Version

A note on the firewall settings

On each server machine, ensure that there is an inbound firewall rule which allows incoming traffic
on the specific TCP port used by BETA LM, for example for the default TCP port 6007.

A note on launching the beta_Im license manager on Virtual Machines

Root privileges are required when running beta_Im on a Linux Virtual Machine. The only exception is
when the Virtual Machine is running on a Xen hypervisor. More details are available in the
Knowledge Base article: License Manager for Virtual Machines

Troubleshooting actions for installation problems are given at the end of this document.

2.3. Supported beta_Im features

A short description of the available features of the beta_Im license management system is
summarized in the following table:

Available
Feature Description through
The total number of licenses can be distributed (equally or not)
to a number of machines that will be used as alternate license
Server Redundancy  servers. Two redundancy schemes are available: a hardware license.dat
failover and a license distribution scheme through multiple
servers

Flexible Short Term ANy number of addltlonal s_hort term licenses that will cover .

peak workload will be provided upon request. These will be license.dat
integrated into the existing licensing file and will expire on

prescribed dates.

Licensing

BETA CAE Systems Page 16


https://support.beta-cae.com/servicedesk/customer/kb/view/26217634

BETA LM

Setup Guide

Group Licensing

Combinations of specific software products as well as software
features can be set to hold a specific amount of the total
available credits, provided by the standard license system (e.g.
metapost, ansa-catia).

license.dat

Shared Licensing

No extra licenses will be held for multiple software executions
provided that these are requested from the same user, on the
same physical machine/console and from the same license
server.

license.dat

Disconnect Idle
Users

If a user remains idle within a specific time interval, then the
current session will be considered as disconnected and the
corresponding licenses will become available to other users.

Note that the idle session will not be lost, but any attempt to
resume working will subject to current license availability.

If no licenses are available, a dialogue menu appears giving the
option to Retry to acquire license or to save the working session
and/or exit.

licence.opt
and

license.dat

Configure Feature
usage and Idle user
timeout rules

Specific filters can deny, limit or exclusively allow usage of
particular features by particular users. Likewise, the idle user
timeout can be configured to be applicable only to particular
users or during specific timeframes within a day.

licence.opt
and

beta_Im_control

The Administrator (with full administrative privileges) has the

"Kill"' Selected Users ©Ption to terminate the processes of a specific user, or to beta_Im_kill
terminate processes on specific machines.
A general log-file records all activities related to license license.log
. L. requests, denials due to saturation, license usage, application '
Statistics and . . .
Logging versions, exit conditions, server changes etc.
Also, on-line statistics report the current licensing status. beta_Im_stat
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2.4. More on FEATUREs, CREDITs and PACKAGEs

There are some important keywords used in every portion of the license file that control the way that
licenses are distributed among the licensed applications. These keywords are:

24.1.

FEATURE: It represents any application or procedure that is asking for a license.

For example, ANSA or META constitute FEATURES. In addition, procedures like running a
script (ANSA_BATCH), META_POST_BATCH post-processing, ANSA_CATIA_V4 translation
etc. are FEATURES as well. FEATURES can be stand-alone or can belong to a PACKAGE.

PACKAGE: This defines a group of FEATURES, i.e. a group of licensed applications or
procedures (as defined above). FEATURES that belong to the same PACKAGE draw credits
from the pool of credits that is assigned to this PACKAGE.

WEIGHT: It is the currency of the transaction between the license server and the licensed
FEATURE.

CREDIT: It represents the total amount of credits that become available through the license
file, as well as the amount of credits necessary to launch a specific application or procedure.

FEATURESs and their important keywords (WEIGHT, CREDIT and OPTIONS)

The stand-alone applications that our licensing system, beta_lm, is called to manage are:

ANSA

META

CAD Translators
KOMVOS
RETOMO

NEERE

..and others...

In addition to the above, there exist features (i.e. aspects of functionality or procedures) embedded
in these applications that are also licensed when used, for example:

special “operation modes” of an application (e.g. running an automatic, unsupervised
instance of the application without any user interface, for example ANSA Batch Mesh, when
running through script)

the conversion of a CAD-data file (e.g. conversion of a CATIA V4 or V5 file into ANSA format)
a special reduced environment for the communication with a third-party tool (e.g. the TOSCA
optimizer)

EPILYSIS solver (when called though ANSA)

Machine Learning Environment (available through KOMVOS)

..and others...

In our licensing system language, all above are called FEATURES:

FEATURE=ANSA
FEATURE=META_POST
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e FEATURE=NEW_ANSA_CATIA_V5
e FEATURE=ANSA_BATCH

e FEATURE=ANSA_TOSCA

e FEATURE=TOMO

In essence, a FEATURE can represent either a stand-alone application or an aspect of its
functionality.

When an instance of a FEATURE is called to run it will need to engage a specific number of credits.
This number is determined by the keyword WEIGHT:

e FEATURE=ANSA, WEIGHT=100 (ANSA needs 100 credits to launch)

e FEATURE=META_POST, WEIGHT=33 (META needs 33 credits to launch)

e FEATURE=NEW_ANSA_CATIA_V5, WEIGHT=25 (a CATIA V5 to ANSA translation needs 25
credits)

e FEATURE=ANSA_TOSCA, WEIGHT=30 (the reduced ANSA-TOSCA Environment needs 30
credits to launch)

e FEATURE=TOMO, WEIGHT=100 (RETOMO needs 100 credits to launch)

As mentioned before, the CREDIT determines the maximum number of credits that a FEATURE is
allowed to engage:

e FEATURE=ANSA, WEIGHT=100, CREDIT=2300 (total ANSA credits cannot exceed 2300)
e FEATURE=META_POST, WEIGHT=33, CREDIT=100 (total META credits cannot exceed 100)
e FEATURE=TOMO, WEIGHT=100, CREDIT=100 (total RETOMO credits cannot exceed 100)

In other words, the CREDIT keyword assigns an individual pool of credits that can be used by this
FEATURE only.

Finally, the OPTIONS keyword determines whether a new instance of the FEATURE will engage
additional credits or not, if launched by the same user on the same machine. The ‘shared’ OPTIONS
implies that no extra credits whereas the ‘blank’ OPTIONS implies additional credits.

e FEATURE=ANSA, WEIGHT=100, ... ... ..., OPTIONS="shared’ (no extra credits for new ANSA
instances)
e FEATURE= NEW_ANSA_CATIA_V5WEIGHT=25,... ... .. , OPTIONS=" ' (a new CATIA V5

translation would need another 25 credits)

A note on the ‘shared’ OPTIONS

If an instance of a FEATURE is launched remotely on a machine/display where another instance of
the same FEATURE already runs (locally), the “sharing” of credits is disabled and additional credits
will be required. Also, “sharing” of credits is disabled among different license servers. More details
are available in the Confluence KB article: Sharing license credits error

2.4.2. The pre-post PACKAGE

The PACKAGE is a collection of FEATURES. The most frequently used PACKAGE is the PRE_POST:

e PACKAGE=PRE_POST
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Each PACKAGE contains a CREDIT keyword to designate a pool of credits that becomes available to
its members:

e PACKAGE=PRE_POST, CREDIT=2300

In essence, each FEATURE within a license file can exist either independently or as a member of a
PACKAGE:

¢ When a FEATURE is standing independently within a license file, then this FEATURE
occupies credits from its own, individual, pool of credits that is defined in the CREDIT= value
of the FEATURE

e When a FEATURE becomes a member of a PACKAGE, then the number of credits stated in
the CREDIT= value of the FEATURE represent the maximum number of credits that this
FEATURE is allowed to engage from the total number of credits that this PACKAGE can
deliver.

A license file may contain more than one PRE_POST PACKAGE, each distributing a different pool of
credits to its contents (FEATURES):

PACKAGE=PRE_POST, CREDITS=2432
FEATURE=ANSA, PACKAGE=PRE_POST
FEATURE=ANSA_BATCH, PACKAGE=PRE_POST
FEATURE=ANSA_CATIA_V4, PACKAGE=PRE_POST
FEATURE=ANSA_TOSCA, PACKAGE=PRE_POST
FEATURE=ANSA_UG, PACKAGE=PRE_POST
FEATURE=META_POST, PACKAGE=PRE_POST
FEATURE=META_POST_BATCH, PACKAGE=PRE_POST
FEATURE=META_POST_OLD, PACKAGE=PRE_POST

Pool of 2432 credits,
serviced by
PACKAGE=PRE_POST.
These credits are accessible
only to the FEATURES of
the PRE_POST Package
(see above)
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2.4.3. Examples

Now, let’s try to interpret some sections of the license file in order to gain a better understanding of
these keywords, their interaction and how they control licensing:

21 SN=1, PACKAGE=PRE_POST ,CREDIT=2432,ISU=10-oct-2014,EXP=31-jan-2015,SIGNATURE=1e\

PACKAGE=PRE_POST: A package called PRE_POST is defined

CREDIT=2342: This package can serve a total of 2432 credits to its FEATURES
(see below)

The package was issued on 10-oct-2014 and will expire on 31-jan-2015

24 SN=1, FEATURE=ANSA , PACKAGE=PRE_POST ,WEIGHT=100,CREDIT=2300,0PTIONS="'shared’', SIG\

FEATURE=ANSA: A licensed application called ANSA is defined as a FEATURE
PACKAGE=PRE_POST: This FEATURE (i.e. ANSA) belongs to a PACKAGE,
namely the PRE_POST package

WEIGHT=100: The WEIGHT of ANSA is 100 credits; so when ANSA is called to
launch, the license server will have to engage 100 credits; these will have to be
deducted from the total of 2432 credits that the PRE_POST package can serve
(line 21)

CREDIT=2300: There is an upper limit on the total number of credits that a
FEATURE can occupy within a PACKAGE. In this example, this limit for ANSA is
set by CREDIT=2300. So, although the PRE_POST package can serve a total of
2432 credits (as seen in line 21), ANSA can utilize only 2300 credits; in other
words, there can be no more than 23 individual ANSA instances running at the
same time. It will be seen later that the remainder 132 credits of the package
are utilized by META

OPTIONS="shared’: FEATURES having the ‘shared’ option will not engage
additional credits if launched by the same user on the same machine. We have
seen in this example that the first instance of ANSA will need 100 credits to
launch; but, since ANSA is ‘shared’, any additional instance launched by the
same user on the same machine will continue to use the same 100 credits
engaged by the first ANSA instance.

30 SN=1,FEATURE=ANSA CATIA V4 ,PACKAGE=PRE_ POST,WEIGHT=25,CREDIT=2300,0PTIONS=' ',\

FEATURE=ANSA_CATIA_V4: A licensed procedure, the conversion of CAT-
IA_V4 files into ANSA native format, is defined as a FEATURE
PACKAGE=PRE_POST: This procedure belongs to the PRE_POST package; it
will therefore engage credits from the same pool of credits that is made avail-
able to all applications that belong to PRE_POST

WEIGHT=25: When the CATIA_V4 to ANSA conversion procedure is launched, it
will ask for and engage 25 credits

CREDIT=2300: The maximum number of the total PRE_POST credits that can
be engaged by this feature is limited to 2300

OPTION=" "Unlike ANSA in line 24, this feature is not ‘shared’. This effectively
means that each of the CATIA_V4 to ANSA instances will ask for and will have
to engage 25 credits (regardless if launched by the same user on the same
machine). In other words, 2 instances will need 50 credits, 3 will need 75 and
so on.

42 SN=1, FEATURE=META POST, PACKAGE=PRE_ POST,WEIGHT=33,CREDIT=2432,0PTIONS='shared’\

In this line, an application called META is defined, that belongs to the
PRE_POST package. Its WEIGHT is 33 credits so, if called to launch, META will
ask for and engage 33 credits. It is also seen that META is ‘shared’, so addi-

BETA CAE Systems Page 21



BETA LM Setup Guide

tional instances by the same user on the same machine will still use the al-
ready engaged 33 credits

« What is important in line 42 is that the maximum number of credits that META
can use is 2432. This effectively means that (unlike the rest of the licensed
FEATURES), META can use all the credits that PRE_POST package can deliver.

52 SN=1, FEATURE=NEW_ANSA CATIA V5,WEIGHT=25,CREDIT=25,ISU=10-oct-2014,EXP=31-jan-\
53 2015,0PTIONS=' ', SIGNATURE=f7£5776ba498a9730felddfdbde52acbde76432ec0e£5809147\

« Thisis an example of a stand-alone FEATURE. As such, the
NEW_ANSA_CATIA_VS does not belong to any PACKAGE, it has its own validity
period (ISU and EXP) and it will use its own pool of credits (CREDITS=25). Each
instance of this feature will engage 25 credits (WEIGHT=25), so effectively
there can be only 1 instance running at any given time. Notice also that the
FEATURE is not ‘shared’, meaning that if additional instances were to be
launched, each would have to engage 25 credits.

118  SN=5,FEATURE=TOMO,WEIGHT=100,CREDIT=100,ISU=28-jan-2020,EXP=31-jan-2021,0PTION\
S='shared',h SIGNATURE=fdbflabfl313falcccfefd934b73b0aal8e4e16438d55a10d0dc38£74\

e Thisis an example of a stand-alone FEATURE, corresponding to an application
called RETOMO. As such, the TOMO does not belong to any PACKAGE, it has
its own validity period (ISU and EXP) and it will use its own pool of credits
(CREDITS =100). Each instance of this feature will engage 100 credits
(WEIGHT=100), so effectively there can be only 1 instance running at any given
time. Notice also that the TOMO FEATURE is ‘shared’, so additional instances

by the same user on the same machine will still use the already engaged 100
credits.
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2.5. BETA Licensed applications: credits/user

BETA License Manager should be up and running prior to the installation of any BETA application.

e Pre-processing Software System ANSA, (100 credits/user)
e ANSA Batch Mode (100 credits/session)

e ANSA CAD-data Translation for CATIA V4 (25 credits/user)
e ANSA CAD-data Translation for UG/NX (25 credits/user)

e ANSA-TOSCA feature for optimization (30 credits/user)

e Post-processing Software System META, (33 credits/user)
e META Batch Mode (33 credits/session)

e ANSA CAD-data Translation for CATIA V5 (25 credits/user)

e ANSA CAD-data Translation for Pro Engineer (100 credits/user)

e ANSA CAD-data Translation for JT Open (25 credits/user)

e RETOMO (100 credits/user)

e SPDRM / Simulation Process, Data and Resources Management (follows separate licensing
scheme)

e EPILYSIS solver requires the corresponding license FEATURE (100 credits/user)

When EPILYSIS is called through ANSA, by selecting SOLVE IN ANSA, the ANSA session
freezes and EPILYSIS starts solving, switching the occupied credits from ANSA to EPILYSIS
FEATURE. When solving finishes, credits are switched back to ANSA.

If the option SOLVE OUT OF ANSA is selected, then ANSA remains active for the user to
continue working and EPILYSIS starts by occupying additional 100 credits from the EPILYSIS
FEATURE, (200 credits in total).

If the user needs to run EPILYSIS from ANSA and then load (automatically) the results in
META which is launched, 133 credits are in overall occupied.

Finally, when EPILYSIS solver is called independently, through a command prompt,
100 EPILYSIS FEATURE credits are used.

e Since v22.1.0, upon launching KOMVOS, 30 credits/user are occupied.

In prior versions, the credits were shared with ANSA, namely, when ANSA and KOMVOS
were both up and running, 100 credits were overall occupied.

Since v21.1.0 however, the two products do not share credits, thus an extra KOMVOS li-
cense FEATURE is needed in the license file.

e Machine Learning Environment, available through KOMVOS, requires the ML_SERVER license
FEATURE (100 credits/user).

e ANSA Embedded Clips identification via Utilities>Isolate>Embedded Clips or Feature Manag-
er>Recognize>Fastener>Emvedded Clips, requires the ML_SERVER license FEATURE (100
credits/session)
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ANSA Kinetics>Simulation>SPH, requires the SPH_SOLVER license FEATURE (100 cred-
its/user)

DEEN requires the corresponding DEEN license FEATURE (33 credits/user).

Fatigue live prediction application requires the corresponding FATIQ FEATURE (100 cred-
its/user).
FATIQ in batch mode requires the FATIQ_BATCH FEATURE (100 credits/user).

NEERE requires 3 specific license FEATURES:

NEERE_SERVER (100 credits)
NEERE_ROOM (10 credits / active room, i.e at least one user is in the room)
NEERE_USER (1 credit / active user in a room)

All three NEERE license features are acquired from the server so the clients are not re-
quired to have any of them.

ANSERS server requires 100 credits of the ANSERS_SERVER feature.

If there is at least one connection to an SPDRM server, ANSERS requires additionally 50 cred-
its of the ANSERS_DM_SPDRM feature, but further connections to SPDRM servers do not in-
crease the credits required.

If there is at least one connection to a file-based DM, ANSERS requires additionally 50 cred-
its of the ANSERS_DM_FS feature, but further connections to file-based DMs do not increase
the credits required.

If there is at least one connection to an ASAM-0DS server, ANSERS requires additionally 50
credits of the ANSERS_DM_ASAM feature, but further connections to ASAM-0ODS servers do
not increase the credits required.

If there is at least one connection to a SimManager server, ANSERS requires additionally 50
credits of the ANSERS_DM_SIMMANAGER feature, but further connections to SimManager

servers do not increase the credits required.

Each active front-end user requires 10 credits of the ANSERS_USER feature.
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Section 3.
Options and usage of
License Administration Tools

3.1. The beta_lm options

As discussed in earlier paragraphs the beta_lm command initiates the license daemon. The
corresponding command is:

beta Im -f [full path to the license filel]*
NOTE: Alternatively, the single name of the license.dat and license.log files can be used, if navigated

to the directory where the license file is located.
Additional flags are:

-L [full path to the log file]: writereportlog information to this file (recommended)

-h [hostname or ip address] : specify the license server machine

-p [portnumber] : specify the communication port

-install : installation option (Windows only)

—-debug : run in interactive mode for debugging (Windows only)
-remove : remove the beta_lm service (Windows only)

-host key : generate a license key based on ethernet adapter

-ni [USB, WiFi] : generate a license key based on USB, WiFi

-noadmin : run beta_lm as a console app in case the user does not

have Administrator rights (Windows only). In this case,
the beta_Im command should be:

beta 1m -noadmin -f C:\beta Ilm tools\win64\license.dat -L
[full path to]license.log

Then a licensed application can start using the flag:

-h port@server name flag

NOTE: The Command Prompt needs to stay open (Windows only)

* |n its simplest form, the "-f" for Linux and "-install -f* flags for Windows would suffice to initiate the
license daemon. However, it is strongly suggested that the "-L" flag followed by a log filename is also
used:

beta Im -f [full path to]llicense.dat -L [full path to]license.log

beta Im -install -f [full path to]license.dat -L
[full path to]license.log

In this way the license daemon is able to print in the license.log file useful messages concerning the
service installation, debugging or license monitoring.
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3.1.1. Terminating beta_lm

A. LINUX Platforms

open a command prompt and terminate beta_lm by issuing a "kill' command followed by any
signal - except "-9" - and the PID of the parent beta_lm process. It is recommended to use
the "-3" (QUIT) or "-15" (TERMINATE) signal for this action.

NOTE: Killing beta_lm using the "-9" signal will cause abnormal termination and the licensing
system will not function correctly, especially in cases where a server redundancy scheme is
used.

B. WINDOWS Platforms

In order to terminate beta_lm in WINDOWS systems, the administrator should access the
"BETA LM Service" from Control Panel > Administrative Tools > Services and select to "stop"
the service. Moreover, in order to remove the beta_lm service, the administrator should open
a command prompt, navigate to the beta_lm_tools folder and use the beta 1m -remove
command.

3.2. The beta_Im statistical tools

Basically there are two statistical tools for the BETA License Manager service:

First, the beta_lm_stat report, which is used to provide information about the current licensing

status.

Second, the license.log file (optional), where the full license communication between the License
Manager and the client machines is recorded, along with several other useful information.

3.2.1 The beta_lm_stat options

The corresponding command is:

beta Im stat -options

with options:

-h [server hostname] : specify the server that information is required from

-a : request individual information about all users

-u [username] : request information about a specific user

-u [username@hostname] : to request information about a specific user, at a
specific host

-5 : request extra information about shared sessions. Must
be combined with one of the -a,-u flags

-X : request extra information about active features

(application version, 0S, GPU info etc). Must be
combined with one of the -a,-u flags

Depending on the used option, the following information is acquired:

(a) using the -h [server hostname] flag. For example, if we want to see the status of a

specific license server called server name, we type:

beta Im stat -h server name

and the result looks like:

Trying 6007@server_name

Found License daemon on server_ name
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STATUS REPORT

PACKAGE | ISSUED | EXPIRE |  CREDIT
PRE_POST | Wed Sep 11 2019 | Mon Oct 26 2020 | 5000 first section
NEW_ANSA_CATIA V5 | Wed Sep 11 2019 | Mon Oct 26 2020 | 300
PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE_POST :ANSA | 5000 | 100 | 2(3) |1
PRE_POST : ANSA_BATCH | 5000 | 0 | 0(%) | O d secti
PRE_POST:META_ POST | 5000 | 0 [ 0(s) |0 second section
PRE_POST:ANSA_CATIA V4 | 250 | 0 | 0(%) | 0
NEW_ANSA_CATIA V5 | 250 | 0 | 0(%) | 0
PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE third section
PRE_POST | 5000 | 100 | 2(%)

- At the first section, we get information on the currently licensed packages along with the
duration and the corresponding credits of each package.

- At the second section, we get information about the current usage of each feature, i.e. of each
licensed application that is currently running.

-At the third section, the current usage per package is shown. The information is available both
as an absolute value of used credits, as well as a usage percentage, over the total amount of
credits available for each package.

NOTE: All the above sections are repeated when using the -a and -u flags.

(b) using the -a flag returns information about all active users. We type:
beta lm stat -a

and the result looks like:

Trying 6007@server name ....

Found License daemon on server_name

Usage Report for users: all

USER NAMEQ@HOST | FEATURE | PID I START
userl@hostl (:0) | ANSA | 0 | Mon Apr 6 15:00:17 2020
user2@host2(:0) | ANSA | 0 | Mon Apr 6 16:07:14 2020 logged users
user3@host4 (:0) | ANSA | 0 | Mon Apr 6 16:11:07 2020
user4@host3(:0) | ANSA | O | Mon Apr 6 16:19:44 2020
STATUS REPORT
PACKAGE | ISSUED | EXPIRE | CREDIT first section
PRE POST | Wed Sep 11 2019 | Fri Oct 23 2020 | 5000
ANSA_CATIA V5 | Wed Sep 11 2019 | Fri Oct 23 2020 | 300 (as before)

50000

N 5

PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE POST:ANSA | 5000 | 400 | 8(%) | 4 )
PRE POST:META POST | 5000 | 0 | 0(%) | O second section
PRE_POST:ANSA_OLD | 5000 | 0 | 0(%) 10 (as before)
PRE_POST :ANSA_CATIA V4 | 250 | 0 I 0(%) | O
ANSA_CATIA V5 | 300 | 0 I 0(s) | O

PACKAGE USAGE REPORT
third section

PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE (as before)

PRE_POST | 5000 | 400 | 8 (%)

NOTE: A zero p1D indicates a shared process.
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(c) using the -u [username] flag returns information about a specific user. For example, if we
type:

beta Im stat -u user2

we will get information about user2 on all machines:

Trying 6007@server name ....
Found License daemon on server_name

Usage Report for users: user2

USER NAME@HOST | FEATURE | PID | START
user2@host2(:0) | ANSA | O | Mon Apr 6 15:00:17 2020
user2@hostl (:0) | META POST | O | Mon Apr 6 15:06:26 2020

STATUS REPORT
PACKAGE | ISSUED | EXPIRE | CREDIT
PRE_POST | Wed Sep 11 2019 | Fri Oct 23 2020 | 5000
ANSA CATIA V5 | Wed Sep 11 2019 | Fri Oct 23 2020 | 300

PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE_POST:ANSA | 5000 | 200 | 4(%) | 2
PRE_POST:META POST | 5000 | 0 | 0(s) |0
PRE_POST:ANSA OLD | 5000 | 0 | 0(%) | O
PRE_POST:ANSA_CATIA V4 | 250 | 0 | 0(%) | O
ANSA CATIA V5 | 300 | 0 I 0(%) 10

PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE
PRE_POST | 5000 | 200 | 4(%)

(d) We can restrict information by indicating the hostname where a user is logged by typing:
beta Im stat -u user2@hostl

and the result will be:

Trying 6007@server name ....

Found License daemon on serverl.localdomain
Usage Report for users: user2@hostl

USER NAME@HOST | FEATURE | PID | START
user2@hostl (:0) | META POST | O | Mon Apr 6 15:06:26 2020
STATUS REPORT
PACKAGE | ISSUED | EXPIRE | CREDIT
PRE_POST | Wed Sep 11 2019 | Fri Oct 23 2020 | 5000
ANSA CATIA V5 | Wed Sep 11 2019 | Fri Oct 23 2020 | 300
PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE | USAGE
PRE_POST : ANSA | 5000 | 0 | 0(%) | O
PRE_POST:META POST | 5000 | 33 | 0(s) |1
PRE_POST:ANSA OLD | 5000 | 0 | 0(%) 1|1 0
PRE_POST:ANSA CATIA V4 | 250 | 0 | 0(%) | O
ANSA CATIA V5 | 300 | 0 | 0(%) | O
PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE
PRE_POST | 5000 | 33 | 0(%)

(e) We can request more information by using the —x and/or —s options, combined with either
-aor-u:

beta 1lm stat -a -x

which will result in additional information in the Usage Report:
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USER NAMEQ@HOST | FEATURE |
user2@hostl (:0) | META POST |

PID
0

beta Im stat -a -s

I START
| Mon Apr 6 15:06:26 2020| 21.0.0

| VERSION | OS

| Linux (GPU card info) |

which will result in detailed report for all active shared sessions of each user:

Trying 6007@server name ....

Found License daemon on server name

Usage Report for users: all
USER NAME@HOST | FEATURE | PID | START
+userl@hostl (:0) | ANSA | O | Mon Apr 6 15:00:17
|userl@hostl (:0) | ANSA | 15352 | Mon Apr 6 15:00:17
|userl@hostl (:0) | ANSA | 13255 | Mon Apr 6 16:07:14
+user2@host2 (:0) | ANSA | 0 | Mon Apr 6 16:11:07
|user2@host2 (:0) | ANSA | 15476 | Mon Apr 6 16:11:07
STATUS REPORT
PACKAGE | ISSUED | EXPIRE | CREDIT
PRE_POST | Wed Sep 11 2019 | Fri Oct 23 2020 | 5000
ANSA CATIA V5 | Wed Sep 11 2019 | Fri Oct 23 2020 | 300
PACKAGE : FEATURE | MAX CREDIT | CREDIT USED | USED PERCENTAGE
PRE_POST:ANSA | 5000 | 200 | 4(%)
PRE_POST:META POST | 5000 | 0 | 0(%)
PRE_POST:ANSA_OLD | 5000 | 0 I 0(%)
PRE_POST:ANSA CATIA V4 | 250 | 0 I 0(%)
ANSA CATIA V5 | 300 | 0 | 0(%)
PACKAGE USAGE REPORT
PACKAGE | MAX CREDIT | CREDIT USED | USED PERCENTAGE
PRE_POST | 5000 | 200 | 4(%)

2020
2020
2020 logged users
2020
2020
first section
(as before)
USAGE
2 .
0 second section
0 (as before)
0
0

third section
(as before)

The logged users section shows all the active shared sessions in detail. The initial session, that
engaged the license credits, is recorded with a line starting with (+) and holds a zero PID. All the rest
shared sessions are recorded with a line starting with (|). In this case, user 1 has launched 2
different ANSA instances, while user2 has launched 1 ANSA instance only. The total credits used are
shown on the rest of the sections, as normal.
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3.2.2. Monitoring license usage

When the beta_lm license manager is installed using the "-L1" flag, the license log file records all the
licensing communication information along with several other useful information. The content of
this log file looks like:

FEATURE USERNAMEQ@HOST PID START
ANSA userl@hostl (:0) 2467 Wed Mar 23 21:23:14 2020
ANSA_BATCH user2@host2(:0.0) 1554 Wed Mar 23 21:32:10 2020
META_POST userl@hostl (:0) 0 Wed Mar 23 21:33:52 2020
\
END EXIT INFO oS Version
Wed Mar 23 21:24:47 2020 NORMAL_PROGRAM EXIT Windows 21.0.0
Wed Mar 23 21:38:02 2020 CLIENT LOST Linux 20.1.2
Wed Mar 23 21:40:24 2020 IDLE_USER_TIMEOUT Windows 21.0.0
J
where:
FEATURE . corresponds to the running licensed application (e.g. ANSA)
USERNAMEQ@HOST . indicates the user, machine and display console (linux) or session id
(windows) of the running application
PID : the corresponding Process ID (Zero PID indicates a shared feature)
START / END : starting and termination time of the application
EXIT INFO . indicates the condition under which the application is stopped. Available
messages are:
NORMAL PROGRAM EXIT, CLIENT LOST, IDLE USER_TIMEOUT,
RELEASED BY USER, KILL USER BY ADMIN, TIMED CREDITS_CHARGED,
FEATURE RELEASED, NOT ENOUGH PRE POST CREDITS
0s : the operating system of the machine that the application is launched
Version : the version of the running application (available since ANSA/ META

version 20.1.2 and onwards)

The license.log file also records license request denials due to saturation (xor ENouGH PRE_POST
crep1Ts). The users that have asked for a license and are currently in the queue are listed and shown
in the .log file. Extra information on the total (the sum of waiting time, so that all the clients in the
queue get a license) and average waiting time is also provided.

Additionally, a more advanced style of the license.log file can be provided. This recording mode is
invoked through the license.opt file (see next chapter ), using the keyword "LOG_STYLE=1".

More specifically, detailed license traffic information, per application session, is reported.

Every single license call, successful or not, is recorded, like shown next:

Mon May 18 14:25:08 2020 (betalm) IN: "ANSA" "21.0.0" user@apollon(:0.0) [27349]

Mon May 18 14:26:38 2020 (betalm) IN: "ANSA BATCH" "21.0.0" user@apollon(:0.0) [27629]

Mon May 18 14:26:52 2020 (betalm) OUT: "ANSA BATCH" "21.0.0" user@apollon(:0.0) [27629] (FEATURE_RELEASED)
Mon May 18 14:26:52 2020 (betalm) IN: "ANSA" "21.0.0" user@apollon(:0.0) [27629]

Mon May 18 14:27:02 2020 (betalm) DENIED: "ANSA" "20.1.2" user2@host8 (:2) [7988]

(NOT ENOUGH CREDITS ( WAITING TIME FROM BETA_LM STARTUP: TOTAL=89702 sec , AVERAGE=150 sec ))

Mon May 18 14:27:03 2020 (betalm) OUT:"ANSA" "21.0.0" user@apollon(:0.0) [27629] (NORMAL PROGRAM EXIT)
Mon May 18 14:27:13 2020 (betalm) OUT:"ANSA" "21.0.0" user@apollon(:0.0) [27349] (NORMAL PROGRAM EXIT)

Continuation
of.log file
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It is possible to reset the starting time from which statistics for the license.log are calculated,
without terminating the process (see section 3.4).

All information acquired either from the global log file or through the current licensing status is
suitable for input to standard spreadsheet tools (e.g. EXCEL, OpenOffice etc.) for further statistical
processing.

3.3. The beta_lm_kill_user options

This tool is used in order to terminate the processes of a specific user. The command is:

beta Im kill user -options

with options:
-u [username@hostname] - kill all processes of a specific user at a specific host
-i [proc_id] - kill a specific process-id
-n [hostname] - kill all processes of a specific host

An example of killing a user could be:

beta Im kill user -u user2@hostl(:0)

which will kill all processes of user2 that run on host1 using the default display (:0).

NOTE: The beta 1m kill user command can be issued only from the user that initiated the
beta 1m daemon (i.e. the Administrator with full administrative privileges). On WINDOWS systems,
the Administrator should be logged in as Root (i.e. as Administrator with full administrative
privileges).

3.4. The beta_lm_control options

This tool is used to communicate with the license manager for various tasks. The appropriate syntax
to be used is:

beta Im control -options

with options:
-h [hostname] -reloadopt : define the server hostname and reload the
license.opt file without the need to restart the BETA
LM service
-h [hostname] -resetstats : define the server hostname and reset the time from

which statistics for the license.log are calculated
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Section 4.
The Administrator Options File

4.1. The administrator options file

The administrator options file (license.opt) is a single text file that can be downloaded from BETA
CAE Systems secure site and used by the administrator in order to configure several parameters of
the licensing system. Its use is optional and it serves cases where the administrator wishes to
customize the behavior of the license service with regards to various features.

One or more valid parameters, as outlined in the next sections, can be used. The file should be
edited accordingly and saved in a specific directory, for example at the directory where the
license.dat is located. Additionally the license file (license.dat) should also be edited, using a reliable
editor, concerning the line starting with: OPTIONS=.... Enter there the full path of the license.opt file
and save.

For example:

#HHH A START OF EDITABLE SECTION

# Replace FULL_PATH_TO in the next line with the full path of the directory
# where license.opt file resides.
OPTIONS=C:/beta-cae/beta_Im_tools_v7.x/win64/license.opt

The license.opt file is read upon the beta_Im service startup. However, it can also be reloaded,
without interrupting the service, using the command:
beta 1lm control -h [hostname] -reloadopt

4.1.1. Idle User Timeout

One of the configurable parameters in the options file is the maximum time (in minutes) that a user
may remain idle, before the corresponding reserved credits are released. In general, as Idle is
considered a user that has not taken any action in ANSA/META for longer than the time defined as
Idle User Timeout. When such a user will take action again, there are two cases:

- If there are available license credits, BETA License Manager will provide the needed credits and
the user will continue working, without any notification

- If there are no available license credits any more, the application will be interrupted, asking the
user to SAVE & Quit or to retry re-acquiring license

The respective syntax in the license.opt file is: IDLE_USER_TIMEOUT=

So if, for example, the administrator wishes license credits to be released after a user being idle for

30 minutes, the keyword that should be used in the options file is:
IDLE_USER TIMEOUT=30

The minimum acceptable value is 10 minutes. If the IDLE USER TIMEOUT parameter is set below
the minimum value (except zero), it will be switched automatically to the minimum, i.e. 10 min. If the
parameter is missing or set to zero, then no limitations are applied.

NOTE: When the Idle User Time Out option is active, the respective notification appears in the
application’s terminal upon start-up. Older application versions report at starting that
IDLE_USER_ TIMEOUT less than 20min is not accepted. In those versions, the idle time setting
automatically switches to 20min, releasing credits after 20min, as expected.
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Apart from setting the idle time limit, it is also possible to configure the applicability of this limit

per user, group of users, IP addresses or hostnames. The filtering options for configuring the idle
user timeout are applicable since versions 19.1.7, 20.0.4, 20.1.2 and 21.0.0 onwards. It is also
possible to configure the idle time limit to be enabled or disabled during specific timeframes within
the day (since version 21.0.0 onwards). The appropriate syntax and some examples of each filtering
option are provided in the tables below:

Syntax in .opt file

Description

IDLE_DISABLE {FEATURE}
users=.../groups=..../hosts=.../ips=...

IDLE_ONLY {FEATURE}
users=.../groups=..../hosts=.../ips=...

IDLE_TIME_RANGE_DISABLE-=...

IDLE_TIME_RANGE_ONLY-=...

Example

The idle user timeout will be ignored for the
defined feature, when launched by the
defined users, groups, hosts or IP addresses.

The idle user timeout will only be applied to
the defined feature, when launched by the
defined users, groups, hosts or IP addresses.

The idle user timeout will be ignored during
the defined time range.

The idle user timeout will only be applied
during the defined time range.

Description

IDLE_DISABLE ANSA users=demo,demo’

IDLE_DISABLE ANSA groups=group1,group2

IDLE_DISABLE ANSA hosts=WIN100,LIN200

IDLE_DISABLE ANSA ips=192.168.2.1,192.168.2.3
IDLE_DISABLE ANSA ips=192.168.2.1-192.168.2.6
IDLE_DISABLE ANSA ips=192.168.2.0/8

IDLE_ONLY ANSA users=demo,demo1

IDLE_ONLY ANSA groups=group1,group2

IDLE_ONLY ANSA hosts=WIN100,LIN200

IDLE_ONLY ANSA ips=192.168.2.1,192.168.2.3
IDLE_ONLY ANSA ips=192.168.2.1-192.168.2.6

The feature ANSA will not be subject to the
idle user timeout for the listed users.

The feature ANSA will not be subject to the
idle user timeout for users belonging to the
listed groups.

The feature ANSA will not be subject to the
idle user timeout when it is launched by the
listed hosts.

The feature ANSA will not be subject to the
idle user timeout when it is launched by the
listed IP addresses.

NOTE: The syntax 192.168.2.0/8 means that

the last 8 bits of the defined IP address will
be ignored.

Only the feature ANSA will be subject to the
idle user timeout and only for the listed
users.

Only the feature ANSA will be subject to the
idle user timeout and only for users
belonging to the listed groups.

Only the feature ANSA will be subject to the
idle user timeout and only when it is
launched by the listed hosts.

Only the feature ANSA will be subject to the
idle user timeout and only when it is
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IDLE_ONLY ANSA ips=192.168.2.0/8 launched by the listed IP addresses.

NOTE: The syntax 192.168.2.0/8 means that
the last 8 bits of the defined IP address will
be ignored.

IDLE_TIME_RANGE_DISABLE=08:00-14:00 The idle user timeout will be disabled

between 08.00-14.00 hours.

IDLE_TIME_RANGE_ONLY=08:00-14:00 The idle user timeout will only be applicable

between 08.00-14.00 hours.

NOTES:

a)

All the filters above can be used with the syntax “=*" to include all users, groups, IPs, hosts,
respectively.

The groups of users (given after the syntax “groups=") should be defined in the system by
the system administrator, for example on the LDAP and/or in the client machines and/or on
an Active Directory. This means that users should see themselves belonging in these
groups on their (client) machines. To verify this, depending on the operating system, users
can use the command whoami /groups for Windows OS and id <username> for Linux
0S. Please note that in case of inappropriately defined groups, for example in the case of
mixed Windows and Linux OS users, the defined filters might erroneously seem not to be
applied.

4.1.2. Allow, deny or limit the access to specific features

A series of options is offered in order to configure the usage of specific features according to the
user, group of users, IP addresses and hostnames. The access to particular features by particular
users may be denied, exclusively allowed or limited to a specific number. These filtering rules are
applicable from versions 19.1.7, 20.0.4, 20.1.2 and 21.0.0 onwards. The appropriate syntax and
some examples of each filtering option are provided in the tables below:

Syntax in .opt file Description

DENY {FEATURE} users=.../groups=..../hosts=.../ips=... The defined feature will not be available,

when launched by the defined users, groups,
hosts or IP addresses.

DENY {FEATURE} users=.../groups=..../hosts=.../ips=... The users, groups, hosts or IP addresses
exclude users=.../groups=.../hosts=.../ips=... defined after the “exclude” word are

excluded from the DENY filter and will be the
only ones able to launch the defined feature.

ALLOW_ONLY {FEATURE} Only the defined feature will be available and
users=.../groups=..../hosts=.../ips=... only when launched by the defined users,

groups, hosts or IP addresses.

LIMIT {FEATURE}: {instance_LIMIT} The number of instances that the defined
users=.../groups=..../hosts=.../ips=... feature can be launched by the defined

users, groups, hosts or IP addresses is
limited to a specific number.

LIMIT:{subgroup_name} {FEATURE}:{instance_LIMIT} The number of instances that the defined
users=.../groups=..../hosts=.../ips=... feature can be launched by the defined

subgroup of users, groups, hosts or IP
addresses is limited to a specific number.
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LIMIT:{subgroup_name}:{credit_LIMIT} {FEATURE}
users=.../groups=..../hosts=.../ips=...

LIMIT:{subgroup_name}:{credit_LIMIT} {FEATURE}
users=.../groups=..../hosts=.../ips=... exclude
users=.../groups=.../hosts=.../ips=...

GROUP {group_name} users=...

LIMIT:GR1_GR2_GR3:TOTAL- RES_GR1 - RES_GR2 -
RES_GR3 {FEATURES}/* users=* exclude
groups=GR1,GR2,GR3

LIMIT:GR1_GR2:TOTAL- RES_GR1 - RES_GR2
{FEATURES}/* users=* exclude groups=GR1,GR2

LIMIT:GR1_GR3:TOTAL- RES_GR1 - RES_GR3
{FEATURES}/* users=* exclude groups=GR1,GR3

LIMIT:GR2_GR3:TOTAL- RES_GR2 - RES_GR3
{FEATURES}/* users=* exclude groups=GR2,GR3

This syntax allows defining different
limitations to different subgroups.

The number of credits that the defined
feature can be launched by the defined
subgroup of users, groups, hosts or IP
addresses is limited to a specific value.

This syntax allows defining different
limitations to different subgroups.

The users, groups, hosts or IP addresses
defined after the “exclude” word are
excluded from the limitation.

The defined users will belong to the defined
group.

Credits reservation is also possible by
applying limits in combinations. Assume the
following scenario:

e Allcredits = TOTAL

o Reserve RES_GRT1 credits for GR1 group
e Reserve RES_GR2 credits for GR2 group
o Reserve RES_GR3 credits for GR3 group

The syntax to achieve the above reservation
is the one presented on the left. Note that
this syntax can be used for fewer or more
groups as well. In the case of more groups,
extra lines are needed (1 for each new group)
and extra excluded groups at each line.
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Example

Description

DENY ANSA users=demo,demo1

DENY ANSA groups=group1,group2

DENY ANSA hosts=WIN100,LIN200

DENY ANSA ips=192.168.2.1,192.168.2.3
DENY ANSA ips=192.168.2.1-192.168.2.6
DENY ANSA ips=192.168.2.0/8

DENY ANSA users=* exclude users=demo1,demo2

ALLOW_ONLY ANSA users=demo,demo’

ALLOW_ONLY ANSA groups=group1,group2

ALLOW_ONLY ANSA hosts=WIN100,LIN200

ALLOW_ONLY ANSA ips=192.168.2.1,192.168.2.3
ALLOW_ONLY ANSA ips=192.168.2.1-192.168.2.6

ALLOW_ONLY ANSA ips=192.168.2.0/8

LIMIT ANSA:1 users=demo,demo1

LIMIT ANSA:2 groups=group_1,group_2

LIMIT ANSA:1 hosts=WIN100,LIN200

LIMIT ANSA:3 ips=192.168.2.1,192.168.2.3
LIMIT ANSA:3 ips=192.168.2.1-192.168.2.6
LIMIT ANSA:3 ips=192.168.2.0/8

The feature ANSA will not be available to the
listed users.

The feature ANSA will not be available to the
users belonging to the listed groups.

The feature ANSA will not be available when
launched by the listed hosts.

The feature ANSA will not be available when
launched by the listed IP addresses.

NOTE: The syntax 192.168.2.0/8 means that
the last 8 bits of the defined IP address will
be ignored.

The feature ANSA will be available only to
users demo1 and demo?2.

Only the feature ANSA will be available for
launching and only by the listed users.

Only the feature ANSA will be available for
launching and only by users belonging to the
listed groups.

Only the feature ANSA will be available for
launching and only when launched by the
listed hosts.

Only the feature ANSA will be available for
launching and only when launched by the
listed IP addresses.

NOTE: The syntax 192.168.2.0/8 means that
the last 8 bits of the defined IP address will
be ignored.

Only one instance of ANSA will be available
among the listed users. As long as one user
has launched ANSA, the other listed users
will be denied access.

Only two instances of ANSA will be available
among users belonging to the listed groups.
The third attempt to launch the feature by
one of the users belonging to the listed
groups will lead to access denial.

Only one instance of ANSA will be available
among the listed hosts. The second attempt
to launch the feature by one of the listed
hosts will lead to access denial.

Only three instances of ANSA will be
available when launched by one of the listed
IP addresses. The fourth attempt to launch
the feature by one of the listed IP addresses
will lead to access denial.

NOTE: The syntax 192.168.2.0/8 means that
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the last 8 bits of the defined IP address will

be ignored.
LIMIT ANSA:3 groups=group1,group2 In total only three instances of ANSA will be
LIMIT ANSA:3 users=demo,demo available among users belonging to the

listed groups and the listed users. The fourth
attempt to launch ANSA by one of the
aforementioned users will lead to access
denial.

This syntax is used in order to define extra
pools of users/groups of users/hosts/IP
addresses to the same rule in a different
command line.

LIMIT:subgroupA ANSA:2 groups=group1,group2 Two instances of ANSA will be available
LIMIT:subgroupB ANSA:1 users=demo,demo among the users belonging to group1 and

. % group?2; one instance of ANSA will be
LIMIT ANSA:4 users available for users demo and demo1, while
the general limitation will be four licenses for
all the users in total.

LIMIT: subgroupA ANSA:2 groups=group1,group2 In total only two licenses of ANSA will be

LIMIT: subgroupA ANSA:2 users=demo3,demo4 available among the users belonging to
group1 and group2 and users demo3 and
demo4.

This syntax is used in order to define extra
pools of users/groups of users/hosts/IP
addresses to the same LIMIT sub-rule in a
different command line.

LIMIT:subgroupA:200 * groups=group1,group2 Two hundred credits for all features will be
LIMIT:subgroupA:200 * users=demo1,demo2 available among the users belonging to
group1 and group2 and users demo1 and
demo2; one hundred credits for all features
will be available for users demo3 and

LIMIT:subgroupB:100 * users=demo3,demo4

demod4.
LIMIT:subgroupA:200 * groups=group1,group2 exclude Users demo1 and demo?2 are excluded from
users=demo1,demo?2 the limitation, meaning that the number of

credits they can use is unlimited.

GROUP group1 users=demo1,demo2,demo3 Users demo1, demo2 and demo3 compose a
group named as group1.

LIMIT:ALL:900 * users=* exclude groups=NVH,CRASH,CFD | Assume there is a pool of 1500 credits in

LIMIT:grA:1000 * users=* exclude groups=CRASH,CFD total and there is need to reserve 100 credits
for NVH group of users, 200 for CRASH and

LIMIT:grB:1100 * users=* exclude groups=NVH,CFD 300 for CFD. The syntax to achieve this
LIMIT:grC:1200 * users=* exclude groups=NVH,CRASH reservation is the one presented on the left.
NOTES:

a) All the filters above can be used with the syntax “=*" to include all users, groups, IPs, hosts,
respectively.

b) Itis also possible to use negative values as limits for the allowed features. In such cases,
when a feature is subject to shared licensing, the total number of shared feature sessions is
limited. For instance, assuming ANSA has been granted shared licensing:
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LIMIT ANSA:-2 users=demol,demo2 means that if a user launches two instances of
ANSA in the same machine, the limit will have been reached hence no third ANSA will be al-
lowed to be launched, by anyone. This serves cases where limiting of hardware resources is
required. It is noted that although the two instances of the same feature by the same user in
the same machine will be counted as individual, the credits occupied will still be counted
once, as expected due to the shared licensing nature of the particular feature.

c) When a license is denied due to one of the above options, the following message
(or a similar one, based on the B ANSA_2100
application version), appears Trying 60078uave . ...
in the terminal window: Pound License daemon on uave

Unable to Register Feature AMSA : Server rules applied

Communication Failed with Licenze daemon on 6BB7Fwave ....
Feature Registration took 2 seconds.

d) All the filters above are listed when running beta_Im_stat.

e) The groups of users (given after the syntax “groups=") are the groups defined in the system
by the system administrator, for example on the LDAP and/or in the client machines and/or
on an Active Directory. This means that these users see themselves belonging in these
groups on their (client) machines. To verify this, depending on the operating system, users
can use the command whoami /groups for Windows OS and id <username> for Linux
0S. Please note that in case of inappropriately defined groups, for example in the case of
mixed Windows and Linux OS users, the defined filters might erroneously seem not to be
applied.

f)  When the same group of users is defined both in the system and in the license.opt file using
the GROUP syntax, then priority is given to license.opt GROUPs definition.

g) Multiple lines definition for the same LIMIT filter or the same LIMIT:{subgroup_name} sub-
filter should be followed by the same licenses number limitation.

h) The {FEATURE} definition in the LIMIT:{subgroup_name}:{credit_LIMIT} filter can be re-
placed with the “*” character to include all features.

4.1.3. Privacy Level Options

Since beta_Im version 7.1 onwards, in order to cater for reveal of personal information concerns, it is
possible to define the required privacy level through the license.opt file.

Setting the option UserPrivacyLevel=1 in the license.opt file will disable listing of usernames and
hostnames, when executing beta_Im_stat.

In addition, since versions 22.0.0, 21.1.2., 21.0.3 and 20.1.6, listing of usernames and hostnames
from the applications’ terminals upon startup is disabled. The only options from the license.opt file
that appear in the users’ terminals are the ones referring to the idle user timeout and any potential
filters set for it.

NOTE:

Regardless of the presence of UserpPrivacyLevel=1, the user running the beta_Im service will still
be able to see the usernames and hostnames of all users either in beta_lm_stat or in the terminal
window of the applications.
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Section 5.
The License.dat File

5.1. The license.dat file

The license file license.dat holds all information that is necessary for the proper and uninterrupted
use of the licensed application. This file is unique and is created for use with the customer's
designated license servers and respective license scheme. Moreover, since it is a file required by the
beta_Im to manage all licensed applications, it should be installed to every server that is running a
beta_lm daemon.

A typical license file contains:

1. An editable section for the optional administration options file (to be discussed later)

2. License server names and host-ids and corresponding communication ports

3. A not-editable section with the licensing specifications and any possible features of the
licensed applications (any unauthorized modifications of this section will result in license
termination)

and has the following structure:

Line Typical License File

O ~Joy Ul bW

e

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36

#

# This file is a license file for use with beta Ilm License Manager
# Run as Administrator : beta lm -f full path to this file

#

HHH4 44444444 START OF EDITABLE SECTION

# Replace FULL PATH TO in the next line with the full path of the directory
# where license.opt file resides.
OPTIONS=FULL_ PATH_ TO

# Replace SERVER NAME in the next line with the hostname of your server
SERVER=SERVER NAME, PORT=6007

H4#4H #4444 44444 END OF EDITABLE SECTION

SN=1,HOSTID=200a025ec00b5f5e0£f1b2e1b3d5e020bd04e5144,ISU=08-jul-2003,EXP=25-s\
ep-2004, OPTIONS="'COMPANY="yourcompany name",Tn=10, Tm=40, Ts=20,WCL=60, nodebug, \
ACD=10,ART=5,FRC=15, SSC=3, SIGNATURE=07ab9%9e1920137cb1f0137cb07ab9%e19207ab9%e192\
0137cb1£0137cb07ab9e192cb011d719207ab9e192019e1920137cb1£0137¢c9e1920137c07ab9\
e1920137cbl1f0137cb07ablf01e4432d2£3dd7¢9e1920137cb1£0137¢c
SN=1,PACKAGE=PRE_POST,CREDIT=3000,SIGNATURE=9el920137C07ab9el920137Cblf0137c7\
cdb1£013719207ab%9e192019e1920137cb1£0137¢9e1920137c07ab9e1920137cb1£f0137cb07a\
b1£0137¢c21e2d401cb9e1920137¢cb1f0137cb07a

SN=1, FEATURE=ANSA, PACKAGE=PRE_POST, WEIGHT=100, CREDIT=3000, ISU=08-jul-2003, EXP\
=25-sep-2004,0PTIONS="shared', SIGNATURE=90a137c07ab9%e1920137cb1£f0137cb07acdbl\
7137cb07aecd2d223419207ab9%9e192019e1920137cb1f0137¢9%9e1920137c07ab9%9e1920137cbl1f\
0137¢cb07abl1£0137
SN=1,FEATURE=ANSA7CATIA,PACKAGE=PRE7POST,WEIGHT=25,CREDIT=ZOO,ISU=08—jul—20—0\
3,EXP=25-sep-2004,0PTIONS=" ', SIGNATURE=9€19d12037c07ab9e1920137cbl1£f0137cb07a\
1f013712da37c\aecd2211ceab%9e12019e1920137cb1£f0137¢c9%9e1920137c07ab9%e1920137cblf\
0137¢cb07abl1£0137c201cb

SN=1, FEATURE=META_ POST, PACKAGE=PRE POST,WEIGHT=33,CREDIT=300, ISU=08-jul-2003,\
EXP=25-sep-2004,0PTIONS=" ', SIGNATURE=9e19d201317c07ab%9e1920137cb1£f0137cb07ae\
b1£0137137cb07332c37137cb07332caecd223407ab9%e1920137cb1f0137cb07aecdblf013713\
7cb01£0137

- Lines 1-4 contain information about the license daemon installation.

- Lines 6-15 represent the editable section of the license file. In line 10 the administrator may
optionally provide the location of the "administration options file", which contains all
configurable parameters of the licensing system (see Section 4).
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- Line 13 holds information about the license server machine and communication port, so the
administrator should fill in the corresponding values. Note that the default communication
port is 6007. Normally, a license file has one SERVER line. If more SERVER lines appear it
means that a license scheme with redundant servers is used.

- Whatever follows below line 15 belongs to the not-editable section and any modifications
will result in license termination. This not-editable section contains all licensing specifications
(such as software groups, total number of credits and duration of each group etc) and is
created by BETA CAE Systems based on a unique key that is supplied by the customer.

The licensing specifications are divided into sections which in turn are characterized by a
serial number, an identification, the duration and an encrypted digital signature key. A brief
description of the corresponding flags used in these sections is given below:

Flag Description
SN= This is the serial number of the current section of the license file.
HOSTID= This is the host-id of the License Server. It corresponds to the

server_name given in line 13. See next paragraph on how to obtain
a valid host-id.

ISU= & EXP= Line 17: Duration of the license file.

Lines 25, 29 and 33: Duration of the current section of the license
file. Can be different from the total duration that is set for the
license file but cannot exceed the duration set for the license file.

OPTIONS= Line 17: This is the company name for which the license file is
prepared for and installed.

, .| Lines 26, 30 and 34: Additional options related to the current
shared' | ection.

Note that in line 26, the 'shared' option specifies that the current
licensed application (ANSA) will reserve a single license if it is
requested by the same user for the same machine/console.

Tn= ,Tm= ,Ts=, Reserved Flags.

WCL=, ACD=,

FRC=,

SSC=

SIGNATURE= Encrypted digital key of the current section.

PACKAGE= This flag is used in order to define a licensed application “group”.

For example, in line 22 a group called “PRE_POST" is defined and
3000 credits are assigned to this group.

CREDIT= Total credits available for this section. If this section belongs to a
PACKAGE or FEATURE, then these are the total credits for this
package or feature.

FEATURE= A "feature" can be either a specific licensed application (like ANSA
in line 25), or a specific software-feature that consumes a different
number of credits (like the ANSA_CATIA translation in line 29).
Such FEATURES can either belong to a software PACKAGE or can
be stand-alone.

WEIGHT= This is the "weight" of a FEATURE, i.e. the number of credits that
are reserved by one instance of the FEATURE. The weight of all
currently running FEATUREs cannot exceed the corresponding
number of CREDITS assigned to this FEATURE. For example, in line
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29, it is apparent that up to a total of 8 ANSA_CATIA instances are
allowed to run, since the weight of each one is 25 and the total
credits are 200.
MAINTENANCE= This is the maintenance expiration date for either the PACKAGE or

TZOFFSETMIN=
TZOFFSETMAX=

the FEATURE. It is used only for licenses that do not include
unlimited maintenance or for perpetual licenses. The message:
FEATURE [Feature_Name] EXCEEDED MAINTANANCE PERIOD will
appear in the log file monitoring the license.

This only appears when a license file is locked to machines that
have a Time Zone which falls between the minimum and maximum
offset — TZOFFSETMIN and TZOFFSETMAX, respectively,
compared to the server. The message: FEATURE [Feature_Name]
EXCEEDED TIMEZONE RANGE will appear in the log file monitoring
the license.

5.2. Additional short term licenses and license extensions

When a license.dat file is created for the very first time by BETA CAE Systems, the serial numbers of
all packages / features are set to SN=1. If an additional short term license is requested by the
customer for one or more of packages / features, then BETA CAE Systems will issue a new license
file having a higher SN for the respective packages / features. In order beta_lm to realize such
changes, the administrator should:

e Stop the beta_Im service
¢ Replace the license.dat file with the updated one

e Restart the beta_lm service
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Section 6.
Running a Licensed Application

6.1. Searching for a valid license

When the end-user launches an application, this client application will search on several locations to
find the license server name(s). On each server it will search for available floating licenses. The
locations are searched in a sequential order and are given below:

#  Location Contents Notes
1. -h <port@server,...> A I|§t of ports and servers where a license can be command argument
retrieved from

2. -f <path/license.dat> Path to the license file command argument
3. BETA_LIC_FILE Path to the license file environment variable
4  ANSA_HOME Search the ANSA and META installation directories for ~ ANSA and META

" META_POST_HOME the license file inherent variables
5. current directory Search the current working directory for the license file -

A list of ports and servers where a license can be
retrieved from

A list of ports and servers where a license can be
retrieved from

A list of ports and servers configured by the
administrator where a license can be retrieved from

9. localhost Search for a license at localhost -

6. BETA LIC_ SRV environment variable

7. ANSA SRV environment variable

8. ansa_srv DNS alias

INOTE: If the search fails in all above locations, the application will not start. The license server
name(s) is indicated at the SERVER line of the 1icense.dat file provided by BETA CAE Systems.

Locations 1, 6, 7 and 8 point directly to the provided server name, while locations 2, 3, 4 and 5 point
to the SERVER line of the 1icense.dat file.

Location 1. The end-user has the option to declare a specific license server by its name or
IP-address, using the -h flag:

ansa -h port@server

or
ansa -h port@ip

When a redundancy scheme is used, the above command should be like:

ansa -h port@serverl,port@server2,portl@server3

Location 2. In addition, it is possible to run the application using the - £ option to point to the
license.dat €.g.

ansa —-f [full path to]license.dat

Locations 3,6, 7. BETA LIC FILE,BETA LIC SRV and ANSA SRV are set as environment varia-
bles (see paragraph 6.1.1 and 6.1.2).

Location 4. ANSA HOME (or META POST_HOME) is a variable defined by the application and corre-
sponds to the pathname of the config folder inside the application’s installation directory. This op-
tion requires the 1icense.dat file to be placed within this folder.
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Location 5. This option requires the 1icense.dat file to be placed within the current directory. The
current directory corresponds to a directory that can be defined in three ways:
e The directory where the application is invoked when called from a shell or command prompt.
e The “Start in” directory when the application is invoked through a Windows shortcut.
e The directory defined with the —changedir running argument.

Location 8. This option points to the server name set as ansa_srv in the DNS server.
Location 9. This option matches the server name with the 1ocalhost name.
NOTE: The —h option prevails over — £, when given together.

In its simplest form, a licensed application needs to know where in the network, does the
BETA_LIC_SRV environment variable points to. In turn, BETA_LIC_SRV should point to the server or
servers (single server or redundant servers), as these are listed in the corresponding 1icense.dat
file. Related examples are given in the following paragraphs.

6.1.1. Stand-alone server scheme

In a stand-alone server scheme the SERVER=line of the 1icense.dat file indicates the server and
port used by beta_lm to communicate with clients. For example:

SERVER=plank, PORT=6007

Consequently, the BETA_LIC_SRV environment variable should be set as a variable with
BETA LIC_ SRV asnameand 6007@plank as value.

LINUX systems:

Environment variables can be defined globally along with other variables used. For instance, in
the case of bash Unix shell, their definition is declared inthe /etc/profile file, and for csh or
tcsh Unix shell inthe /etc/profile.d/csh.local file. Alternatively, users can declare
variables in their private account workspaces, for example in the .login file or in the resource file
of the preferred Unix shell. In the case of bash Unix shell, the resource file is .bashrc, and for
csh or tcsh Unix shell it is .cshrec.

The command for setting up the environment variable depends on the Unix shell used. Examples
for setting up the BETA_LIC_SRV environment variable for bash, csh and tcsh Unix shells are
given below:

e export BETA LIC SRV=6007@plank for bash Unix shell

e setenv BETA LIC SRV 6007@plank forcsh ortcsh Unix shell.

Type the echo $shell command to get the shell type (e.g. /bin/tcsh).
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WINDOWS systems:

Environment variables can be defined via two different menus, one for system (global) variables
where administrative privileges are required and another one for user variables. To access either
of these follow the path:

Control Panel> All Control Panel Items> System> Advanced system settings> Advanced tab>
Environment variables> System variables or User variables> New.

New User Variable X

Variable name: ‘ BETA_LIC_SRV ‘

Variable value: ‘ 6007@gauss‘ ‘

Browse Directory... Browse File... Cancel

The ANSA_SRYV is defined in a similar manner by setting a variable with ANSA SRV as name and
6007@plank as value.

Accordingly, the BETA_LIC_FILE is defined by setting a variable with BETA LIC FILE as name and
the [full path to]license.dat as value.

6.1.2. Redundant server scheme

As mentioned in paragraph 2.1.1, beta_Im supports two server redundancy schemes; one uses
multiple servers for license distribution and one is for hardware failover protection. The scheme
which is currently used is reflected in the license file (license.dat) delivered by BETA CAE Systems to
the customer. For example a hardware failover scheme would look like:

SERVER=gauss, PORT=6007
SERVER=hilbert, PORT=6007
SERVER=riemann, PORT=6007

In such cases, the licensed application needs to know all alternate servers that may provide the
requested license. Consequently, the BETA_LIC_SRV environment variable should be set as a
variable with BETA LIC SRV asname and 6007@gauss, 6007@hilbet, 6007@riemann as value.

LINUX Systems:

Environment variables can be defined globally along with other variables used. In the case of
bash Unix shell, their definition is declared in the /etc/profile file, and for csh or tcsh Unix
shell in the /etc/profile.d/csh.local file. Alternatively, each user can declare variables in
his private account workspace, for example in the .login file or in the resource files of the
preferred Unix shell. In the case of bash Unix shell, the resource file is .bashrc, and for csh or
tcsh Unix shell itis .cshrc.

The command for setting up the environment variable depends on the Unix shell used. Examples
for setting up the BETA_LIC_SRV environment variable for bash, csh and tcsh Unix shells are
given below:

e export BETA LIC SRV=6007@gauss, 6007@hilbet, 6007@riemann for bash Unix
shell

e setenv BETA LIC SRV 6007@gauss, 6007@hilbet, 6007@riemann for cshor
tcsh Unix shell.

Type the echo $shell command to get the shell type (e.g. /bin/tcsh).
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WINDOWS Systems:

Environment variables can be defined via two different menus, one for system (global) variables
where administrative privileges are required and another one for user variables. To access either

of these follow the path:

Control Panel> All Control Panel Iltems> System> Advanced system settings> Advanced tab>
Environment variables> System variables or User variables> New.

New User Variable X

Variable name: ‘ BETA_LIC_SRV ‘

Variable value: ‘ 6007@gauss,ﬁOO?@hilbert,GOW@riemannl ‘

Browse Directory... Browse File... Cancel

The ANSA_SRYV is defined in a similar manner by setting a variable with ANSA SRV as name and
6007Q@gauss, 6007@hilbert, 6007@riemann as value.

Accordingly, the BETA_LIC_FILE is defined by setting a variable with BETA LIC FILE as name and
the [full path to]license.dat as value.

NOTE: When defining more than one server, “blank spaces” should not exist in-between the server
names.

A note on the server searching order

When more than one servers are declared in the BETA_LIC_SRV variable, the client application will
request for a license by checking these servers in a specific search order: At first, the client will
check the first declared server and then will start checking backwards from the last server to the
second.

As an example consider a server scheme consisting of n servers. The respective BETA_LIC_SRV
environment variable should be declared as a variable with BETA LIC SRV as nhame and
serverl, server2, ....server (n-1), server (n) as value.

In such cases the client will check the servers in the following order:

1. serverl (first declared server)

2. server (n) (last declared server)

3. server (n-1) (second to the last server)
n. server2 (second server)

A note on Licensed Applications running on Virtual Machines

The launching of any application licensed by BETA CAE Systems (e.g. ANSA or META) from within
any type of Virtual Machine may (depending on the application’s version) disable the “sharing” of

credits for this application. In other words, any instance of an application launched through a Virtual
Machine may not share the same license and will occupy the prescribed number of credits.
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6.2. Releasing a license

Since ANSA/META version 21.0.0 onwards, the end-user has the option, to temporarily release the
reserved license without exiting the application. This functionality is accessible within ANSA or
META application via “File > Release License” option. When the license is released, a Confirmation
window appears.

-

E!]Confirmatinn B

G License released!
Press O to acquire a new license

Lo

By pressing the OK button, the application can search again for available licenses. With this option,
the end-user can practically bypass the Idle User Timeout setting.
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Section 7.
beta_lm On The Go

7.0. Introduction to beta_lm On The Go

7.0.1. What is beta_lm On The Go

Problem: Need for an ANSA leasing for a small period of time (short-term), in order to use it on trips
on laptops.

From version 6.1 and on, beta_Im fully supports the usage of a USB Ethernet/WiFi card for the
license server.

For more detailed information regarding the USB Ethernet/WiFi card and the general beta_lm On The
Go features and functionalities, you may refer to the following section.

7.1. Basic Components and Requirements

7.1.1. What is a USB Ethernet/WiFi card

With USB Ethernet/WiFi card, we mean Wireless USB Adapter. Wireless USB is a short-range,
high-bandwidth wireless radio communication protocol. A Wireless USB adapter enables wireless
internet access to either a desktop or a notebook PC. The adapter simply plugs into the external USB
port of the PC. The antenna technology built into the adapter will give full mobility with the notebook,
or enable to place the desktop anywhere at home without the need to use unsightly Ethernet cables.
This device looks like a simple USB, but is a bit bigger, including Ethernet.

7.1.2. Scheme and Hardware requirements

Scheme requirements, as well as Hardware requirements for the beta_Im On The Go application are
given below:

beta_lm On The Go is supported ONLY for Single server scheme for Windows and Linux platforms.

Scheme Availability Platform Availability
Single server YES Windows YES
(64bit OS Version)
Redundant NO LINUX YES
(64bit OS Version)

Note: A prerequisite for beta_Im On The Go operation is that MAC address spoofing is disabled.
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7.2. Procedure and Application

7.2.1. Overview of actions

When it's time to get a general license from BETA CAE Systems, the customer can order x-1 license
for the main server and one license for a USB Ethernet /WiFi card that will be installed on another
server. The client machines will look for licenses first in the main server and if there is saturation,
then they will look for the "USB" server.

In case someone needs to go on a trip with a laptop and needs to launch a Licensed Application
(ANSA/META), then they can take the USB adapter and connect it on the laptop. In this way they will
have an active license at the laptop that can be "returned” upon their return.

The advantage of this scheme is that there is one license that can be taken and used by any
computer with no interaction from our side, and this license’s cost can be included on the total year
budget.

Of course, the disadvantage is that when the USB is away, there is one less license available.

When the USB based license is docked back at the office:

Multiple Server scheme: e.g. server_1 and one USB license on server_2, then the client machines will
have BETA_LIC_SRV = server_1,server_2

NO Redundant Server scheme available.

7.2.2. Installation procedure
In order to receive a license file with the required information

e Select a USB Ethernet adapter and plug it on a Windows platform machine

e Download beta_Im_tools from BETA CAE Systems secure site

e Unpack beta_Im_tools package

e Fetch the information required to build a valid license file, via the command:

beta Im -host key —-ni USB

The execution of this command will provide the three pieces of information that BETA CAE Systems
requires in order to build a valid license for the selected license scheme. This information, its
description as well as the respective command that should be used to obtain, is given in the table
below:

Item description command (WINDOWS only)
name by which this machine
1. hostname is identified within the

customer's network

media access control

2. MAC address
address

beta 1Im -host key -ni USB

beta_Im alphanumeric string
3. host key from USB | based on a USB network
interface

Note: After receiving the license file (license.dat) please mind to change the SERVER line from
SERVER=<hostname> to SERVER=localhost or IP address.
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8.1. Troubleshooting beta_Im

Section 8.
Troubleshooting beta_lm

Troubleshooting actions for problems encountered during installation or operation of the beta_Im
license management tools are given in this paragraph. Since most of these problems are reported in
the "license log" file, it is recommended to use the -L flag during the installation of the beta_lm
license daemon (see paragraph 2.2.7). Also, troubleshooting articles for common problems are

available at the link License Manager.

The following table presents a list of common errors along with the corresponding description and

recovery action.

Error Message

Error Description and Recovery Actions

ERROR 1067: The process terminated
unexpectedly

platform: WINDOWS

description: The beta_lm service could not be started.

recovery: Open a command prompt, switch to the beta_Im_tools
folder and remove the current beta_Im service using the
"beta_Im -remove" command. Then, follow the steps below:

1-

Make sure that the network interface is active, even
though there is no physical connection to any network.

Make sure that the server NAME specified in the
SERVER-= line of the license.dat file is correct and it
corresponds to the machine that will be used as
license server. It might also be necessary to edit this
line and change from:

SERVER=hostname,PORT=6007 to
SERVER=hostname.localdomain,PORT=6007 or
SERVER=localhost,PORT=6007 or
SERVER=IP_ADRESS,PORT=6007

Verify that beta_lm is installed on the same machine
that was declared to BETA CAE Systems as license
server; the HOSTID within license.dat should be
identical to the key reported by running the "beta_lm -
host_key" command

Make sure that the PORT number specified in the
SERVER-= line of the license.dat file is not already used
by another application or is blocked by a firewall.

Make sure that there are no "blank spaces" in the full
path leading to the license.dat file. Replace the location
of the file to avoid blank spaces.

Make sure that all complete lines in the non-editable
section of the license.dat file are not wrapped and they
end with a back-slash "\".
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7- Inrare occasions, it might be necessary to login as
"Administrator" and not as a user with administrative
privileges.

8- Confirm that the date and time settings on the
workstation are correct.

Finally, reinstall beta_Im as described in paragraph 2.2.7.
If the problem persists, contact BETA CAE Systems for
assistance.

ERROR 1063: StartServiceCtrIDispatcher
failed

platform: WINDOWS

description: The beta_lm servive could not be started.

recovery: Use the full path of the license file during the
installation procedure.

ABORTING SERVER: COULD NOT INSTALL
SERVER

platform: ALL

description: The machine where beta_Im is launched and will be
used as license server is different from the machine that is
declared as server within the license.dat file. As a result, the
installation process is aborted.

recovery: Verify that beta_lm is installed on the same machine
that was declared to BETA CAE Systems as license server; the
HOSTID within license.dat should be identical to the key
reported by running the "beta_Im -host_key" command.

SERVER UNDEFINED MODE

platform: ALL

description: The license.dat file does not contain
comprehensive instructions to the server. beta_lm cannot serve
any licenses.

recovery: Contact BETA CAE Systems for assistance.

SERVER APPLICATION ERROR

platform: ALL
description: beta_lm has encountered a serious system error.

recovery: Contact BETA CAE Systems for support.

SERVER Invalid License File

platform: ALL
description: The license.dat file has an invalid SERVER= line.

recovery: Contact BETA CAE Systems for assistance.

Failed FILE address resolution

platform: ALL

description: beta_lm cannot resolve the server name or IP
address.
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recovery: Verify that the SERVER= line of the license.dat file has
the correct server hostname. If the error persists, replace the
hostname with the corresponding IP-address or with "localhost".

To obtain the IP address, open a command prompt window and
use the “ping” command:

ping server_hostname.

Check also if the port is used by any other application.

platform: ALL

ERROR Option -L, file name TOO BIG description: the file name specified for the log file is too big.

recovery: Specify a smaller file name for the log file.

platform: ALL
ERROR Options : check syntax
ERROR Option -c : REMOVE description: Invalid options were used during installation.
ERROR Option -F : REMOVE
recovery: Use valid options. Refer to paragraph 3.1.

platform: ALL

description: There is no license file specified or the path leading
ERROR License File not found to the license.dat file is wrong.

No License File found
recovery: Verify that the license.dat file exists and reinstall
beta_lm using the full path to the license.dat file. See paragraph
2.2.7 for details.

platform: ALL

description: There is no license file specified or the path leading
to the license.dat file is wrong, or the user has no “read”

ERROR License File could not be opened - . .
privileges for the license file.

for read

recovery: Verify that the license.dat file exists, has the proper
privileges, and reinstall beta_lm using the full path to the
license.dat file. See paragraph 2.2.7 for details.

platform: ALL

description: The HOSTID string within the license.dat file does

ERROR in License File: Could not locate not match the one created by the current beta_lm_tools version.

HOSTID match recovery: Verify that the HOSTID string inside the license.dat file

is identical to the one produced by the currently installed version
of beta_Im_tools. If not, install the latest beta_lm_tools and
create a new host key.

platform: ALL

NOT A VALID LICENSE FILE FOUND description: The specified license.dat file is invalid.

recovery: Verify that the HOSTID within license.dat is identical to
the key reported by running the "beta_lm -host_key" command.
Contact BETA CAE Systems for assistance.

BETA CAE Systems Page 51



BETA LM

Setup Guide

ERROR in License File : Signatures did not
verify

platform: ALL

description: The alphanumeric strings at the SIGNATUE= lines
are not valid.

recovery: Contact BETA CAE Systems for assistance.

Signatures don't verify with hostid line
Signatures don't verify with feature line

platform: ALL

description: The alphanumeric strings at the SIGNATUE= lines
are not valid.

recovery: Follow the steps below:

1- Make sure that all complete lines in the non-editable section
of the license.dat file are not wrapped and end with a back-slash
N

2- Verify that the HOSTID within license.dat is identical to the
key reported by running the "beta_Im -host_key" command.

License Error at Line : #

platform: ALL

description: There is an error in this particular line of the license.dat
file.

Disabled # Credits of Package
Disabled # Credits of Feature

platform: ALL

description: These particular credits of the specific feature or
package contained in the license.dat file are disabled (possibly the
feature or package has expired).

Communication Failed

platform: ALL, in hardware failover redundancy scheme

description: The communicated server does not currently serve any
licenses, i.e. is a secondary server. Please circle through the rest of
the

redundant servers.

Not a Primary instance of License daemon

platform: ALL

description: In redundant server schemes, Secondary servers lose
contact

with the Primary. Usually occurs after multiple continuous license
requests to the Primary server.

recovery: Follow the steps below:

1- Upgrade to beta_Im_v7.x

2- Circle through all servers via the 'beta_Im_stat' command, in order
to verify their status
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ERROR In License File: Address in file cannot
be resolved.

Check SERVER Lines for misspelled or
duplicated entries.

platform: ALL

description: The license file lists servers by name. However, the
system needs their IP-Addresses.

recovery: Check whether you have DHCP (Dynamic Host
Configuration Protocol) -i.e. Dynamic Address detection- on your
computer.

DHCP System has an automatic and dynamic allocation of IP-
Addresses and, therefore, it should find all.

OpenSC manager failed

platform: WINDOWS Vista

description: During installation of beta_Im license daemon on
Windows Vista, the specific Error Message appears.

recovery: Follow the steps below:

1- Just before beta_Im installation, go to 'User Accounts'

2- At the respective window go to 'Turn User Account ..... on/off'

3- At the new window notice the flag 'Use User Account Control' —>
this should be UNCHECKED !

4- Restart your PC, as the corresponding message prompts you, and
go ahead with the installation.

Error 193:0xc1

platform: ALL

description: During installation of beta_Im license daemon, the
specific Error Message appears.

recovery: Cross-check and confirm that the installation path of
beta_lm package, as well as the location of the respective license.dat
file, do not contain empty spaces like ..\Program files\ etc. It is
recommended to choose an exemplary path instead, like

C:\beta_Im\ etc.

BETA CAE Systems

Page 53



	Section 0. Quick Installation Guide
	0.1.  Quick installation guide
	0.2.  Updating to newer version

	Section 1. Introduction to beta_lm_tools
	1.1.  Basic components
	1.2.  Overview of features
	1.3.  Hardware requirements

	Section 2. Installing beta_lm_tools
	2.1.  Overview of actions
	2.2.  Installation procedure
	2.3.  Supported beta_lm features
	2.4.  More on FEATUREs, CREDITs and PACKAGEs
	2.5. BETA Licensed applications: credits/user

	Section 3. Options and usage of License Administration Tools
	3.1.  The beta_lm options
	3.2.  The beta_lm statistical tools
	3.3.  The beta_lm_kill_user options
	3.4.  The beta_lm_control options

	Section 4. The Administrator Options File
	4.1.  The administrator options file

	Section 5. The License.dat File
	5.1.  The license.dat file
	5.2.  Additional short term licenses and license extensions

	Section 6. Running a Licensed Application
	6.1.  Searching for a valid license
	6.2.  Releasing a license

	Section 7. beta_lm On The Go
	7.0.  Introduction to beta_lm On The Go
	7.1.  Basic Components and Requirements
	7.2.  Procedure and Application

	Section 8. Troubleshooting beta_lm
	8.1.  Troubleshooting beta_lm


